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Chapter 1: Introduction
This chapter provides an overall description of the FLOW Logger application. This guide is divided
between user instructions and information for administrators and installers.

NOTE: This User Guide assumes that the EditShare FLOW system has been installed and is fully configured.
Refer to the FLOW Administrator’s Guide for details.

General Information

Logging
FLOW Logger allows you to log live captures quickly. This is particularly useful for sports broadcasts
and reality shows, and can also be used in other environments where you need to log live feeds. You
can speed up your logging by clicking predefined descriptors of the action or event, instead of typing
long comments of what is happening. This also enables you to accurately search your logged
footage later without dealing with misspellings or alternative labels.

You can also log multiple captures at once (ganged capture).

You can also log existing, previously ingested media with FLOW Logger, and utilize the same
descriptors and templates you use for live logging.

Refer to the following topics:

● System Requirements
● FLOW Browse and Logger Comparison
● Workflow
● Associated Documents
● Technical Support

The action and event descriptors you use in FLOW Logger are pre-defined in templates set up in
FLOW Control. You can edit these templates and add new ones if you have Administrator level
access in FLOW. Refer to the EditShare FLOW Administrator’s Guide for further information.
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Media Browser
For any media file you have permission to see, FLOW Logger can playback its corresponding proxy
file (if the proxy was made by FLOW) without the need to mount any media directories.

FLOW Logger can also play back high-resolution files directly, if:

● You have mounted the Media Space containing the required high-resolution files.
● FLOW supports the codec used by the high-resolution files.

From FLOW Logger, you can locate media among hundreds of thousands of clips on EditShare
Media Spaces. You can log clips, create sequences, and drag-and-drop media to Avid and FCP bins
before you begin editing.

The Asset Groups function permits users to browse and search for clips in FLOW Logger, including
clips from Media Spaces that have been deleted. Asset Groups also allow users to see clips in FLOW
without adding those users to the Media Space, or granting them permission to mount the Media
Space to see the high-resolution files.

When browsing or searching for clips in FLOW, the user can now see any clip from any Media Space
that is part of an Asset Group to which they belong. A user can belong to more than one Asset
Group, and similarly a Media Space can belong to more than one Asset Group. As long as a user and
a Media Space are assigned to a common Asset Group, the user can see the clips from that space.

System Requirements
You can install FLOW Logger on most Intel-based Windows and OS X workstations provided they
have OpenGL graphics cards and gigabit Ethernet (performance improves with faster workstations).
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FLOW Browse and Logger Comparison
The following table summarizes the functional differences between FLOW Browse and FLOW Logger.

Function Browse Logger

Edit Functions

● Review Clips x x

● Delete Clips x x

● Add In/Out Points x x

● Create Projects and Sequences x

File/Media Management

● Search for Media x x

● Scan  Media Spaces x x

Logging

● Add Markers x x

● Set Default Marker Color and Text x x

● Define multiple Marker Colors and Text x

● Log File-based media x x

● Log Live Feeds x x

● Log Ganaged Captures x x

● Log using Predefined Groups x

Other

● Set Keyboard Shortcuts x x

● Set Reaction Time for Markers x

● Enable verbatim text area x

● Create Reports x x
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Workflow
The following is an example workflow, together with cross-references to relevant chapters within
this User Guide.
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Associated Documents
The following documents are also available from EditShare:

● FLOW Quick Start Guide
● FLOW Browse User’s Guide
● AirFLOW User’s Guide
● FLOW Story User’s Guide
● FLOW Automation User’s Guide
● FLOW Web Scheduler User’s Guide
● FLOW Supported Formats User’s Reference
● FLOW Administrator’s Guide
● FLOW Installation and Update Guide

Reference to the following publications may be useful when operating FLOW with other EditShare Systems.

● EditShare Storage Administrator’s Guide
● EditShare Ark Setup and User’s Guide
● EditShare Geevs Administrator’s Guide

Technical Support
For questions not addressed in our documentation, contact EditShare Technical Support. Have the
exact version number of your FLOW implementation ready.

EditShare strongly recommends that you purchase a support agreement. If you do not have a
support agreement, a per-incident rate may be available.

Please contact EditShare Technical Support at the following URL:

http://www.editshare.com/support
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Chapter 2: Getting Started
This chapter describes how to start FLOW Logger, customize the desktop, and basic use of the media player.

Starting FLOW Logger
NOTE: To enable Live Logging Mode, you must be currently ingesting a media source connected to an SDI
input on the FLOW Ingest server. If the selected channel is not ingesting, the In, Out, and Log buttons will
not function.

File Logging Mode is not affected by this condition.

To start FLOW Logger:

1. If you want to perform Live Logging, as opposed to File Logging, start an ingest in FLOW Browse.

2. Double-click the FLOW Logger icon on your Windows or Macintosh desktop.
3. The login screen opens.

4. Enter your EditShare Username and Password into the named fields.
5. The FLOW client attempts to discover the FLOW Admin server. If the IP Address text box

displays, enter the correct IP Address for the Admin Server.
6. If the Server Group field displays, select the server you want to connect to from the drop

down list.
7. If you want FLOW to keep your login details for the next time you log in, select the

Remember Login box.
8. Click OK.
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9. The client connection status displays on the login screen. If the connection is successful,
FLOW Logger opens.

FLOW Logger Desktop
FLOW Logger allows you to add logging data to live feeds or existing file-based media, using predefined
fields and templates. The screen is divided into panels as shown below.

1. Toolbar 8. Group Category Items

2. Subclip/Logging Buttons 9. Media Clip

3. Media Player 10. File Browser Window

4. Group Members (Avatars) 11. Search Filter

5. Logger Window Tabs 12. Browse Folder Window

6. Logger Window 13. File Browser Window Tabs

7. Verbatim Text Entry Panel
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Toolbar
This window displays the application banner, the logging template drop down list, the logged in
user’s profile, and any shortcuts the user has added from the Settings menu.

Browser Panel
The Browser Panel allows you to look for content on remote folders (Media Spaces), local folders,
and connected devices. A search tool is also built in.
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1. Media Spaces Tab 4. Display Filter a. Details View

2. Search Tab 5. Thumbnail Zoom b. Folders View

3. Browser Window 6. Folders Window c. Thumbnail View

d. List View

e. Captures View

See Chapter 4: The Media Browser.

Media Player
The media player is where you review media prior to, and during, logging.

1. Audio Level indicators

2. Transport Controls (Play, Pause, etc.)

3. In Point subclip button

4. Out Point subclip button

5. Logging button

6. Timecode counter
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See Chapter 3: The Media Player.

Template Window
The template window carries details of the group members, with avatars (thumbnails) and group
actions that you can use for logging your media. You can resize the avatars for readability, see
Changing the Size of Avatars.

Your logging actions are recorded in the Logging Panel.
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Logging Panel
The Logging panel is where the events, actions and markers you log are recorded. The panel has two
tabs: Logging and Markers. In addition to the logging and marker tools, a verbatim text entry panel
allows you to type entries directly into the Logs and Marker tabs.

See Chapter 5: Logging.

Arranging the Desktop
You can resize the FLOW Logger desktop to take up the entire screen, or part of the screen, leaving a
part of your system desktop visible. You can also resize the desktop or individual panels by dragging
them with your mouse. Be aware that there are restrictions to the amount that you can resize the
desktop or its panels.

Toggle Full Screen
You can toggle between full screen and default screen modes using either of the following methods:

● Pressing Ctrl + D (Windows) or Cmd+D (Mac).
● Right-click on the desktop, and from the menu that opens, click Toggle Full Screen.
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Toggle Aspect Ratio
You can toggle between 16:9 and 4:3 aspect ratios by doing one of the following:

● Press Ctrl+Shift+W (Windows) or Cmd+Shift+W (Mac).

● Click the Aspect Ratio button located to the right of the Shuttle control.

The aspect ratio of the Media Player cycles through the following settings: Native, 16:9 and 4:3. The
current aspect ratio setting displays in the Aspect Ratio button.

Resize Windows
To resize windows:

1. Position your mouse between panel frames so that it changes to a double-arrow.
2. With the left button held down, drag your mouse to move the frame borders to the required

position.
3. Release the mouse key.

Dock and Undock Windows
You can dock and undock windows to rearrange them within the FLOW desktop or to separate them
into independent windows.

Windows that can be moved in this manner include:

● Toolbar
● Media Browser
● Template Window
● Logging Panel

The positioning of your windows, whether docked or undocked, is preserved when you log out.
When you log in again, your FLOW windows are set to where you left them last time, even if you log
in from a different workstation.
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Undocking
To undock a window:

1. The docking bar can be identified by its textured appearance. Do one of the following:
a. Move the mouse over the docking bar of the window you want to move.

b. Click on the Undocking button at the extreme right of the docking bar.
2. Hold down the left mouse button, and drag the window to the position you want, either

within or outside the FLOW desktop.
3. Release the mouse button.

Docking
To dock a window:

1. Click and hold the left mouse button over the title bar of the undocked window.

2. Drag the window over the FLOW desktop until a blank panel opens in the application.
3. Release the left mouse button to dock the window into its docked position.
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Unlocking and Locking Dockable Windows
To lock and unlock dockable windows:

● To disable docking, and lock the dockable windows as they are, right-click within FLOW and
from the menu that opens, select ‘Lock dockable windows’.

● To enable the dockable windows again, right-click within FLOW and from the menu that
opens, select ‘Lock dockable windows’.

Customizing the Toolbar
You can assign keyboard shortcuts to your frequently used functions, and even add them as buttons
to the toolbar.

See Using the Keyboard Shortcut Editor.

Changing the Size of Text
You can change the size of the text in most of the panels of FLOW Logger, including the Media
Browser, Logging and Marker panels. The main exceptions are the media player, and template
window. To resize the screen text:

1. Left-click inside the panel that contains the text you want to resize.
2. While holding down the Ctrl key (Windows) or Cmd key (Mac), scroll the mouse wheel

backwards and forwards to decrease or increase the on-screen text size.

NOTE: Not all text elements in a panel will resize, for example column headings.

Changing the Size of Avatars
You can change the size of the group member pictures (avatars) in the Template window.

● Press Ctrl+Minus (-) to decrease the avatar size.
● Press Ctrl+Plus (+) to increase the avatar size.
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Updating Your User Profile
By default, your EditShare user name displays at the top of the Logger desktop. You can change the
displayed name to an alias, for example your full name or nickname. This does not change your user
name within EditShare FLOW.

You can also add a picture or avatar, your email address and status information, which are saved to
the Users tab in FLOW Control, and may be used by the Administrator for your FLOW system. Your
name, alias and avatar also display in other FLOW applications.

To update your user profile:

1. Click on your user name or avatar.

2. The User Details window opens.
3. Enter the alias or alternative name you want to use in the Display Name text box.

4. Optional: Enter your email address in the Email text box.
5. Optional: Enter your status in the Status text box.
6. To change your avatar, click within the dark area at the top of the dialog box. An Open File

dialog box opens. Navigate to the file you want to use and select it. You can use any JPEG file.
7. Click on OK to save your changes.

Your user name displayed in the toolbar will update if you have changed it.
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If you have other FLOW applications open at the same time, the displayed user name in
those applications may not update immediately.

Exiting FLOW Logger
To exit FLOW Logger, do one of the following:

● Press Ctrl+Q (Windows) or Cmd+Q (Mac).
● Right-click in Logger, and from the menu that opens, select Quit.
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Chapter 3: The Media Player
This chapter describes how to use the media player, the timeline, and add In and Out points for subclips.

Selecting and Playing a Media Clip
Video clips can be found on EditShare Media Spaces, and in local folders, including network drives,
on your workstation.

Selecting a File for Viewing or Playback
Video clips can be found on EditShare Media Spaces, and in local folders, including network drives,
on your workstation. To look for files in Media Spaces, do the following.

1. Click on the Media Spaces tab.
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2. Double-click on a Media Space or Local folder to view files in that folder.
3. Folder contents display in the File Browser panel.
4. Click on the View buttons to change the Folder view as required. The view options are

Details, Thumbnails, List or Captures. See Viewing Media Spaces and Folders.

NOTE: Files containing video or still images normally display a thumbnail image for ease of
identification. Files containing audio only do not have thumbnails but display an icon for an
application on your system associated with the file type.

5. When you have found the media file you want to view or play, double-click on the file to load
it into the Media Player.

Playing Video
To play a video clip:

1. Load the video file in to the Media Player, as described in Selecting a File for Viewing or Playback.
2. Click on the Play button to play the clip.

3. The timecode of the clip increments as the clip is played.
4. Audio presence is indicated by activity on the audio channel indicators.
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5. Use the transport controls to navigate through the clip.

Timeline Zoom
To zoom in to a specific area on the timeline, do the following.

1. Left-click and drag a box around the timeline range you wish to zoom.

2. The timeline expands to show the range you selected.

3. To revert to the normal timeline view, right-click on the highlighted area at the bottom of the timeline.

Subclips
Subclips are shorter sections of longer ‘parent’ clips. Subclips exist only as ‘virtual’ clips, comprising
only of start and finish data in the FLOW database.

The frame at which a subclip starts is known as the ‘In’ point, and the frame at which it ends is
known as the ‘Out’ point. Subclips are useful for when:

● The clip duration is too long for the time you have been allocated, and you wish to shorten it.
● The clip contains material which is irrelevant to the subject matter, or which may confuse or

distract the audience.
● You want to create a faster paced clip for visual impact.

You can select a portion of your media clip and drag it into your NLE application as a subclip. You do
this by setting an In point and an Out point in your media clip to mark the start and end points of
your subclip. In and Out points can also be used for logging.
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Creating a Subclip
To create a subclip:

1. Load the clip you want into the media player.
2. Drag the Timeline Indicator to the point where you want your subclip to start (the In Point).

3. The media player displays the frame at the point you positioned the timeline marker. Use
the Frame Back (A) and Frame Forward (B) buttons to move to the precise point you want
the In point.

4. Press the IN button to mark the In Point.
5. A marker for the In Point displays in the timeline, together with a thumbnail of the frame.
6. Drag the Timeline Indicator to the point where you want your subclip to end (the Out Point).
7. Use the Frame Back (A) and Frame Forward (B) buttons to move to the precise point you

want the Out point.
8. Press the OUT button to mark the Out Point.
9. A marker for the OUT Point displays in the timeline, together with a thumbnail of the frame.
10. Press the LOG button to save the details to the Logging panel.

Dragging Subclips into NLEs
With your preferred NLE application and FLOW Logger open side by side, drag the subclip from the
Media Player into a bin on your NLE.

In an Avid editing application, both the subclip and its associated master clip appear in the bin.

In Final Cut Pro, only the subclip appears.
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Chapter 4: The Media Browser
The Media Browser is a flexible tool that allows you to review media and non-media files on Editshare
media spaces, network folders and on your local drives. Once located in the media browser, you can
view metadata about each file, and load audio and video files into the FLOW media player.

FLOW offers two different ways to find media files: Browse and Search. After you find files, you display
them in different ways and you can drag-and-drop them directly into bins in your editing application.

Browsing
In Browser mode you can browse EditShare Media Spaces or your local files (including Media Spaces
that are mounted). Because of FLOW’s tight integration with the EditShare Storage server, you can
search for and review files from EditShare Media Spaces without having to mount them as network
volumes. If you have lots of Media Spaces, this provides an efficient way to find the clips you are
looking for.

The media browser displays all media and non-media files in the selected media space or folder.
When you select a file, its file system details are displayed in the Metadata panel, together with any
metadata from recognized video and audio files. The media player can play a wide range of video
file formats.

If any of your media files do not have a proxy file, you will need to mount the Media Space they
occupy before you can play these files. However, you can still search for files and view their
thumbnails.

Browsing Media Spaces
To browse Media Spaces:
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1. If the Media Browser is not visible, right-click in the Logger window and, from the menu that
opens, select ‘Switch to File Logging’. The Media Browser displays.

2. Click the Media Spaces tab.
3. The Media Browser displays the Media Spaces of which you are a member. Media Spaces are

displayed by type, e.g. AvidMXF, AvidStyle, Managed, Third Party and Unmanaged.
4. If a Media Space is mounted on your workstation, it is highlighted in orange.

NOTE:  If you have proxy files available, you can play these without having Media Spaces mounted.
You cannot, however, play the original files if the Media Space is not mounted.
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5. Click on the ‘+’ button displayed against a Media Space type (Managed, Unmanaged, etc.) to
expand the listing below it. Click on ‘-’ to collapse the listing.

6. Double-click on a Media Space to select it and to display its content.
7. Content in the currently selected media space displays in the Files Window below the Media

Browser.
8. If a listed file does not have a thumbnail image, it will display a system icon relevant to its file

type or default application that can be used to open it. Note that audio files do not have
thumbnails but may still be played in the media player.

Filtering the Media Spaces Display
If you have a larger number of Media Spaces displayed in the Browser, you can filter the results by
specifying the group type or name. Do the following:

1. If the Media Space Filter is not displayed, press Ctrl+F The Filter panel opens in the lower
border of the Media Browser, and is ON by default.

2. To filter the display by name, add part or all the text you want to apply into the Filter text
box. The display updates as you enter your text.

3. To toggle grouping of media spaces into type, click or unclick the Group box.
4. To filter display results by space type (Online or Asset Groups), click or unclick those boxes as

required.
5. You can apply any combination of text box input and click box selection.
6. Press Ctrl+F again to close the Filter panel.
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Using the Files Window

Viewing Media Spaces and Folders
The Files window, which occupies the lower half of the Media Browser, displays all files in the
selected media space, folder or search.

Click any one of the five Display buttons to choose your viewing options:

A. Slider - When the slider ‘A’ is visible, you can use it to vary the size of thumbnails in the Files
Window.

1. Detail View - Displays a thumbnail and metadata in columns that you can sort (see Sorting in the
Files Window).

2. and 3. Thumbnail View - The Thumbnail view displays a pictorial view of each media file.
Hovering the mouse over the file displays a tooltip with metadata information such as filename,
Media Space, and so on. The thumbnails in the Thumbnail view can be resized by moving the slider
‘A’ left or right.

4. List View - Displays thumbnail and metadata information for each clip. The thumbnails in the List
view can be resized by moving the slider to the left or right.

5. Captures View - Displays the components of an ingest: the source, the output, and the clip itself.
Click the file opener (plus sign) to see the sources for that clip. This view is useful for viewing ganged
or multi-camera recordings.
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NOTE:  You may need to scroll to the right to view all the columns.

Viewing Clip Status
Icons to the right of a clip or subclip indicate that clip’s status, as follows:

NOTE:  Only two icons are displayed on subclips, Offline and Archived.

32



Sorting in the Files Window
You can sort the columns in the Files window. Complete the following:

1. Click the heading of the column (Clip Name, Size, Resolution, Date, etc.) you want to sort.

2. Files are sorted in increasing or decreasing alphanumeric order. The arrow in the column
heading name changes direction accordingly.

3. To sort the column information in the opposite order, click it again.

Dragging and Dropping Clips
FLOW Logger supports drag-and-drop of media files into a number of NLE applications, including
Avid, Final Cut Pro, Adobe Premiere Pro and Lightworks. While it is important to be able to find and
preview your media, it is just as important to be able to get this media into your editing application.
With FLOW it is as simple as dragging the media file from the Files Window directly into an Avid or
Final Cut Pro bin. Associated metadata, such as Tape ID, markers, tape name, Comments, custom
fields, etc. is preserved.

You can also drag logged entries (generally called subclips) into your editing application, including
entries logged by users other than yourself.

NOTE:  The Media Space that contains the files you want to work with must be mounted using EditShare
Connect. See Mounting Media and Project Spaces.

When successfully mounted in FLOW, the Media Space is highlighted in orange.

To drag-and-drop clips:

1. Select files that you want to use from the Files window.

NOTE:  You may want to take FLOW out of Full Screen mode before you drag-and-drop files,
particularly if you only have one monitor. Press Ctrl+D (Windows) or Cmd+D (Mac) to toggle Full
Screen Mode on and off.

2. Drag the files directly into the required bin of the target application. The master clip appears
along with the metadata you entered for the file during capture.
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Deleting Files
If you have file-deletion user privileges in FLOW Control, you can delete files from within FLOW
Logger.

NOTE:  Using a ‘Quick’ delete option from this menu causes all instances of the clip type (Online, Backup,
FLOW Proxy, etc.) selected to be deleted. To delete only selected locations of the clip type, use the
‘Advanced’ menu option instead.

1. Right-click on the clip you wish to Delete.
2. From the menu that opens, select Delete.

3. From the Delete sub-menu, select one of the following:
● All - Deletes all components of the selected clips
● Online Clips - Deletes selected files
● Backup Clips - Deletes or removes all known Ark backups.

If you choose to delete "Backup Clips", the delete behavior depends on whether you are
deleting backups on Disk or on Tape.

Deleting From Ark Disk:  Immediately deletes all backups of the clip(s) on Ark Disk, and
frees up space occupied by those clips.

Deleting from Ark Tape: Causes FLOW to "forget" any Ark Tape backup locations for the
chosen clips, but does not actually free up space on the tape as that is not possible with
the LTO tape medium.

● Proxy Clips - Deletes the clip’s proxy file
● FLOW Metadata - Deletes the metadata from the database
● Advanced... - Provides a comprehensive set of delete options. See Advanced Deletion Options.
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4. A message box displays, advising the number and type of files that are selected for deletion.

5. Click Delete to delete, or Cancel to cancel the operation. Deleted files are moved to the
EditShare trash.

Advanced Deletion Options
Advanced deletion options are as follows:

1. On selecting the Advanced option in the delete clips menu, the Delete Clips dialog box opens.

2. Choose to arrange the display by Type, Location, NLE or Clip, by clicking the named button.
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3. Click the + buttons to view child elements within an item branch.
4. Select or un-select the box next to individual items you wish to mark or unmark for deletion.
5. Select or un-select the master box to globally select or deselect all items for deletion.
6. Click Delete to delete all items marked, or click Cancel to cancel the operation.

Program Launcher
NOTE:  To open files from EditShare media spaces, you must first mount the required media spaces as
local drives on your system. Media spaces are mounted using EditShare Connect. See Mounting Media and
Project Spaces.

You must have applications registered on your system for the types of files you wish to open.

You can use FLOW as a program launcher, to open files from media spaces and local drives and load
them into applications on your workstation. This applies to both media and non-media files. In the
case of media files, the original, full size file version is opened, even if a proxy file exists.

1. Right click on the file you wish to open and, from the menu that opens, select Open.

NOTE: If the Open option is not displayed in the menu, you do not have that media space mounted.

2. The file loads into the application associated with the file type on your system.

Browse using Explorer or Finder
NOTE: To browse EditShare media spaces, you must first mount the required media spaces as local drives on
your system. Media spaces are mounted using EditShare Connect. See Mounting Media and Project Spaces.

You can browse FLOW media spaces using Explorer (Microsoft Windows) or Finder (Macintosh).

1. Right click on a file that resides in the media space you wish to browse and, from the menu
that opens, select ‘Explore to’.

If the ‘Explore to’ option is not displayed in the menu, you do not have that media space mounted.

2. The default file manager for your operating system (Windows Explorer or Mac Finder) opens
in the selected file’s location.
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Downloading Proxy Files
You can download the proxy files created by FLOW and save them to a local drive on your
workstation. To download FLOW proxy files:

1. In the Media Browser, right-click on the clip you want to download.

To select multiple clips, hold down the Shift or Ctrl key while left-clicking each clip you want,
and then right-click on your selection.

2. From the menu that opens, select Download Proxy.

3. The Proxy Download dialog box opens.

4. Select Use Clip Name or Use Original Name, depending on whether you want to save your
files using the clip name or FLOW’s proxy file name. The proxy names ‘A’ in the list box
update as you make your selection.

5. Select the Save with .mov extension box to save your files as .MOV files.
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6. Un-select the box against any files you do not want to download. If a box is already
un-selected, the clip may not have a proxy file (as indicated at ‘B’) and you will be unable to
download the file.

7. To change the location where downloaded files are saved, click the Folder button. When the file
explorer window opens, navigate to the folder you want to use and then click Select Folder.

8. Click the Download button to start downloading your files. When each file has downloaded,
its displayed status changes from ‘Pending’ to ‘Completed’.

9. Click the Close button when finished.

Scanning
Providing you have the appropriate privileges, FLOW allows you to scan media spaces and individual files.

Scanning Media Spaces
You can scan media spaces from FLOW Logger. Three scan options are available - Quick, Normal,
and Full.

NOTE:  To scan media spaces from FLOW Logger, you need user privileges to use FLOW Scan. If you are not
sure have privileges to do this, contact your FLOW Administrator.

You can also schedule automatic scans using FLOW Control. See the FLOW Administrator’s Guide.

To scan from Browse:

1. In FLOW Logger, click the Media Spaces tab.

2. Right-click on the Media Space you wish to scan.
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3. From the pop-up menu that opens, select Scan > Scan Speed, where Scan Speed is one of
the following:

Quick - New and modified files are scanned and added to the database. Use this option if
you only have a few new files to add to the database as it takes the least time to complete.

Normal - New and modified files, including their metadata, are updated in the database. This
option is recommended for day to day work. A Normal scan takes longer to complete than a
Quick Scan.

Full - All files and metadata are checked, with updates to the database made where necessary.
Changes to template profiles are included. This option should be used after system updates or
when templates have changed. A Full Scan takes the longest time to complete.

The selected Media Spaces are scanned.

Scanning Individual Files
Sometimes it is desirable to prioritize the scanning of a single file over others. FLOW allows you to
scan individual files into the database, ahead performing a full scan on whole media spaces or
folders, so that proxy files are available immediately for new material.

Do the following:

1. When new files are added to a media space, perform a Quick Scan to register them into the
database. See Scanning Media Spaces.

2. Right-click on the individual files and, from the menu that opens, select Scan. The entries for
the selected files are updated in the database and new proxy files are created.

39



Searching
You can search for text in the entire FLOW database. The search includes log entries, subclips,
marker text, metadata (such as project or tape name), comments, and filenames. You can name and
save more than one search, use wildcards, and drag text from a text file onto the Search tab.
Searches are not case sensitive.

You can search only in Media Spaces of which you are a member. You do not need to have Media
Spaces mounted to search them because you are searching the FLOW database and previous proxies.

Quick Search
Quick Search is the easiest way to look for media. You can search for text in the following items:

● Clip and subclip names
● Clip metadata, e.g. Project, Scene, Take, Comments, etc.
● Sequence names and comments in sequences
● Project names

Searching for Clips
To search for clips:

1. Click on the Search tab.
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2. Enter the text you want to search for in the text box.
3. Click on Quick Search. The results of your search are displayed in the Files Window.

NOTE:  You can refine your searches by adding wildcards (*) and other text markers. See Search
Text Examples for examples.

Search History
To save you retyping search terms you have used before, FLOW keeps a record of the most recent
searches that you have made. To call up the search history:

1. Click inside the Quick Search text box and press the down-arrow key. A popup opens
displaying a list of recent searches. The most recent searches are at the top of the list, the
oldest are at the bottom.

2. Continue pressing the down-arrow key until the search text you want is highlighted.
3. Press the Enter key to select the search text.
4. Click on the Quick Search button to display the results of your search in the lower half of

the Media Browser.
5. Alternatively:

a. Start typing. A popup opens, displaying a filtered list of any items from the search history
that match your text.

b. Press the down-arrow key until the text you want is highlighted.
c. Press the Enter key to select the search text.
d. Click on the Quick Search button to display the results of your search.

Search Text Examples
You can optimize quick searches by using the following text markers, operators and wildcards:

Basic Search

dog - matches anything that contains the text 'dog' (or 'dogs', 'dogleg', etc.) in any metadata field.

“dog” - matches anything that has the word 'dog' in any metadata field.

respects word boundaries; will not match 'dogs', 'dogleg', etc.

dog walking beach - matches anything that contains all the text 'dog', 'walking' and 'beach'.

– does not match any clips that just have a match on one of these fields

– does not care about word order

"dog walking on the beach" - matches anything that contains the whole phrase 'dog walking on the beach’.
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AND / OR Operators

NOTE: Operators ‘AND’ and ‘OR’ must be typed in upper case.

dog OR walking OR beach - matches anything that has text 'dog' or 'walking' or 'beach'.

– can also be written as dog | walking | beach

dog AND walking AND beach – same as default behavior of dog walking beach.

– can also be written as dog & walking & beach.

Wildcards

*word - matches anything with a metadata field whose value ends with 'word', e.g. 'the last word'.

word* - matches anything with a metadata field whose value starts with 'word', e.g. 'word count’.

Exact Match

=dog - matches anything that has a text value of just 'dog'.

=match this exactly - matches metadata field value to match this exactly.

42



Advanced Search
Advanced Searches allow you to filter your searches on one or more criteria. For example, you can
search for clips which contain a specific word or phrase and were created before a given date. You
can create and save more than one search at a time. All searches are saved across all FLOW Browse
sessions until you delete them.

Creating an Advanced Search
To create an Advanced Search:

1. In the Search tab, click on the + button next to the right of the Advanced Search caption.

2. Click on the Cogs icon to open the Advanced Search panel.
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3. Enter the search criteria from the Advanced Search menu, for example, ‘Clipname contains London’.

The search criteria has three components:

a. Category (or metadata name)
b. Operator (e.g. is, is not, contains)
c. Parameter value

NOTE:  The operator and parameter options vary according to the category you choose.

4. Optional: Combine your search with a new search criteria:
a. Click the Add button. A new search filter opens.

b. Enter the criteria for your new search, e.g. Captured earlier than {date}.
c. Optional: Repeat steps a) and b) to add further search filters.
d. Optional: Click the Remove button to remove any filters no longer required.
e. Select ‘All’ or ‘Any’ from the Match drop down list.

5. Click Search.
6. The results of your search display in the lower half of the Media Browser.
7. The search is saved and is available for you to view in subsequent sessions, even when you

log in to FLOW Browse from a different workstation.
8. You can create new searches as described in the previous steps, and these will be stored

with your previous searches.
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Renaming an Advanced Search
By default, searches are named in sequence, for example: ‘Search 1’, ‘Search 2’, and so on. You can
change your searches to more meaningful names as follows:

1. Type the new name for your search directly into the Search name box.

2. Press Enter. Your search is renamed.

Deleting an Advanced Search
To delete an advanced search:

1. Click on the search you wish to delete.

2. Click on the - button next to the right of the Advanced Search caption. The selected search
is deleted.

45



Paged Search Results
When media spaces fill with a large quantity of files, it can take a while for FLOW to display search
results, and for users to read them. To address both issues, you can set FLOW to display searches in
a set of pages. Paged searches work in both Quick and Advanced searches.

1. Search statistics display as normal at the top of the Results panel.

2. Click Next to proceed to the following page.
3. Click Previous to go back to the previous page.
4. The status panel displays the currently selected page number in the search.
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Paged Search Results are not displayed by default. You must have paged searches enabled in FLOW
Browse. See ‘Customizing FLOW Browse’ in the FLOW Browse User’s Guide. You may have to restart
FLOW Logger to allow the changes you made to take effect.

Importing Text into Searches
You can search for clips using text from a text file. Complete the following:

1. Make sure the text you want to use in your search is separated by commas, semicolons, or
new lines in the file.

2. Open the file containing the text.
3. Select the text you want to use in your search.
4. Drag the selected text into either the Quick Search or Advanced Search text box.
5. Click Search. The results of the search display in the Files Window.

Searching for Similar Files
You can refine your searches to look for files with similar names, timestamp, or captures. You can
also search for subclips created from the master clip.

1. In the Files Window, right-click on the clip you want to match.

2. From the menu that opens, select Search...
3. From the Search submenu, select one of the following options:

● By clipname
● By clip period
● By capture
● For subclips

The results display in the Files window.
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Asset Level Metadata
Metadata is normally added using FLOW Browse, but you can perform batch updates of metadata to
files, and export file metadata, using FLOW Logger.

For further information about FLOW metadata, refer to the FLOW Browse User’s Guide.

Batch Updating of Metadata
You can update asset level metadata common to a group of files in a single operation by using the
Metadata Update function. Do the following:

1. Select the file or files containing the metadata you want to update, and then right-click. Hold
down the Shift or Ctrl key when selecting multiple files.

2. From the menu that opens, select Metadata Update.

3. The Metadata Update dialog box opens.
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4. Click the boxes for the metadata fields you wish to update. Text boxes display for the fields
you select.

5. To edit a metadata text box, double-click on the field and then type directly into the box.
6. Click the Update button when finished. A message box opens, confirming the changes to

metadata that will be made to your assets (files).

7. Click Update. Your metadata updates are applied to your files.
8. The Cancel button on the Metadata Update dialog box changes its label to ‘Done’. Click the

button to close the dialog box.

Inserting Wildcards into Batch Metadata
To insert a number in a text field that increments in relation to the position of the file in the
selection, for example: Clip 1, Clip 2, Clip 3, add the operator %n or %N.

You can also insert leading zeros thus:

%n(2): Produces the sequence 01, 02, 03, ..... 09, 10, 11, etc.

%n(3): Produces the sequence 001, 002, 003, .... 099, 100, 101, etc.

Wildcards are supported on all built in text fields (Clipname, Take, Comments, etc.) as well as all
custom metadata text fields.

NOTE: the update confirmation message box displays the wildcard syntax you entered, not the generated
numbering format that is applied to your media.
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Exporting Metadata
You can export asset metadata for a single file or a group of files. The export format is FLOW XML.
Do the following:

1. Select the file or files containing the metadata you want to export, and then right-click. Hold
down the Shift or Ctrl key when selecting multiple files.

2. From the menu that opens, select Metadata Export.

3. The Asset Export dialog box opens.
4. The metadata to be exported displays in the Preview window.

5. Click the following boxes as required:
● Include custom metadata
● Include markers
● Include log entries

6. Click the Folder button to set a folder location where the export file will be saved. A file
manager window opens. Click OK when finished.

7. Click the Export button to save the metadata in the selected folder.
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Creating Reports
You can create reports by dragging and dropping FLOW objects into a web browser. You can create
reports for items such as clip lists, log lists, marker lists, etc.

To create a report:

1. Have FLOW Logger and your web browser open side by side on screen.
2. In FLOW Logger, select the range of text or objects you want to export.
3. Press and hold down the Ctrl+Alt keys, then drag-and-drop the selected text or objects into

your web browser.

4. Release the Ctrl+Alt keys. The Report is created in the web browser in HTML format.
5. The page layout of your report will vary according to the object type you select.
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Chapter 5: Logging
This chapter describes the two logging methods available from FLOW Logger.

NOTE: To enable Live Logging in FLOW Logger, you must be currently ingesting a media source connected
to an SDI input on the FLOW Ingest server. If you select an available channel on which you did not begin to
ingest, the Logger In, Out, and Log buttons do not function.

Refer to the FLOW Browse User’s Guide for instructions on live ingesting.

Live Logging
You can log a live feed. You can also log several captures at once, ganging them so they have a single
log entry.

NOTE: To log with FLOW Logger, you must be currently ingesting material. If you are not currently
ingesting, the Logger In, Out, and Log buttons do not function.

Preparing for Live Logging
To log one or more live feeds:

1. Start an ingest in FLOW Browse on at least one channel (see the FLOW Browse User’s Guide
for details).

2. Start FLOW Logger.
3. Right-click in the FLOW Logger screen, and from the menu that opens, select Switch to Live Logging.
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Alternatively, press the Live Logging shortcut key (the default is Alt+L).

4. A thumbnail of the capture displays in the upper left corner of the Logger desktop, and the
capture plays in the preview window. If more than one channel is ingesting, a thumbnail
displays for each channel.

5. Select a template from the Template drop-down list.
6. The group members and category items for the selected template open.
7. (Optional) To gang more than one capture with a single log entry, right-click, and from the

menu that opens, select ‘Ganged capture logging’.

NOTE: To remove one of the ingests from a ganged capture, deselect the ingest by clicking the
thumbnail again. To turn off ganged capture logging, right-click and deselect the option.

8. Click the Eye icon under the ingest thumbnail to preview it in the media player. The
thumbnail border turns red when selected.

9. Ingested material can now be viewed in the media player.
10. Add log entries as required. See Adding a Log Entry to a Live Feed.
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Adding a Log Entry to a Live Feed
NOTE: To view log entries (thumbnails) in the timeline, you must have the ‘Show log entries on the timeline’
option enabled in Settings.

To add a log entry to a live feed:

1. As soon as you start ingesting, the first log entry displays in the Logging panel. The In Point
time is the first frame of video in the clip, along with a thumbnail from the first frame of
video. The Out Point is undefined.

2. At the point in the clip you want to add a log entry, click the IN button. Alternatively, you can
use the In Point shortcut key (default: I or F9).

3. The In timecode displays in the Log list, along with a thumbnail image.
4. Depending on your settings, a thumbnail also displays in the timeline.
5. Click the group member and / or category items with which you want to label this portion of

the clip. You can select more than one item per group and category.

NOTE: Only the thumbnails for your Group display, the name does not.

6. Complete the log by clicking the OUT button and then the LOG button. Alternatively, use the
keyboard shortcut keys (default: O or F10 for Out Point).

7. Your logged item appears in the Log list, with the categories in the template appearing as
columns.
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Labeling the Capture List
To best suit your workflow, you can choose to display one of the following labels in the Capture List
when live logging: Channel number, Clip Name or Source Name. The label displays below the
previews for each channel that is ingesting.

See Options Tab for details.

Switching Angles
Instead of clicking on each ingest channel to change the camera angle, you can use the built-in
keyboard shortcuts. These allow you to switch between captures 1 to 8 - the numbering is based on
the order of captures displayed in the Capture preview.

The shortcuts do not have any default values, you must assign shortcut keys before you can use
them. See Using the Keyboard Shortcut Editor for details.
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File Logging
You can use FLOW logger to log material that has been captured to a Media space or local folder.

Starting File Logging
To prepare for logging media already on your system, do the following:

1. Open FLOW Logger.
2. Right-click in Logger, and from the menu that opens, select Switch to File Logging.
3. The File Browser opens.
4. Navigate to the file you want to log and double-click it.

5. The file opens in the Logger.
6. Select a template from the Template list.
7. The group members and category items for the selected template open.
8. Add log entries as required. See Adding a Log Entry to a File Ingest.
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Adding a Log Entry to a File Ingest
NOTE: To view log entries (thumbnails) in the timeline, you must have the ‘Show log entries on the timeline’
option enabled in Settings.

To add a log entry, do the following:

1. At the point in the clip you want to add a log entry, click the IN button. Alternatively, you can
use the In Point shortcut key (default: I or F9).

2. The In timecode displays in the Log list, along with a thumbnail image.
3. Depending on your settings, a thumbnail also displays in the timeline.
4. Click the group member and / or category items with which you want to label this portion of

the clip. You can select more than one item per group and category.

NOTE: Only the thumbnails for your Group display - the name does not.

5. Click the OUT button, or use the keyboard shortcut keys (default: O or F10 for Out Point).
6. Complete the log by clicking the LOG button.
7. Your logged item appears in the Log list, with the categories in the template appearing as columns.
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Updating Logging Information

Using the Logging Panel
You can change existing logging information directly in the Logging panel, or provide other logging
information, such as adding comments or a rating.

1. Resize the logging window or use the scroll bar to see items to the right of the window.

2. To change the subclip name, double-click on the Name field, and then type the new name.
Press Enter to save the change.

3. To change the In point of a subclip, double-click on the In point field, select the hours,
minutes and seconds values in turn, and adjust their values by clicking on the associated up /
down arrows.

4. To change the Out point of a subclip, double-click on the Out point field, select the hours,
minutes and seconds values in turn, and adjust their values by clicking on the associated up /
down arrows.

NOTE: The value for the Out Point cannot be lower than the value of the In point.

Alternatively, use the In and Out point markers on the Timeline and drag them to the
positions you want.

5. To update or add a comment:
a. Double-click on the Comments field.

Alternatively, select the marker and press Ctrl+E (Windows) or Cmd+E (Macintosh) to
open the Comments text box.

b. Type your new comment.
c. Press Enter to save your changes.

6. To rate the current clip, on a scale from 1 to 5, press the keys F1 to F5, or click on the Rating
button until you reach the number you want. The button changes color with the rating.
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7. The Logging window also displays groups and actions from your Logging template. You can
update the contents of these fields by clicking on them, and selecting new options from the
drop down list that opens.

8. To remove a log entry, select the entry and then press the delete key.

Inserting Timecodes into Text Fields
You can copy the timecode from the media player timeline and paste it into text fields in the Logging
and Markers panels:

1. Stop the clip at the point in the timeline for which you want the timecode, and then press
Ctrl+Shift+T (Windows) or Cmd+Shift+T (Mac).

2. Click inside the text field in which you want to add the timecode, and then press Ctrl+Shift+T
(Windows) or Cmd+Shift+T (Mac).

Moving In and Out Points
You can move the In and Points in captures using the following shortcuts:

● Move the In Point back by 1s
● Move the In Point forward by 1s
● Move the Out Point back by 1s
● Move the Out Point forward by 1s
● Slip back by 1s (move the In and Out Points together)
● Slip forward by 1s (move the In and Out Points together)

The shortcuts do not have any default settings, you must assign the shortcut keys and, optionally,
toolbar buttons before you can use them. See Using the Keyboard Shortcut Editor for details.
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Interleaved Log Entry View for Multiple Captures
You can open multiple captures and see all the log entries for those captures in a single view. This is
useful for viewing a rundown of logging of, for example, an entire day’s captures.

1. Open one of the Asset views (flat list, folder view, capture view etc) and select the clips from
the captures you want to view. It does not matter if you select multiple clips from the same
capture as FLOW counts each capture only once.

2. Right-click on your selection and, from the menu that opens, click on ‘Open Captures’.
3. The Logging panel opens and displays the log entries from all the selected captures, sorted

in clip name order.

4. You can sort and edit the Logging panel as normal.
5. The media player displays one of the captures, which you can scrub through and log as

normal. All other functionality for logging (editing, dragging to NLEs, exporting, etc.) are
available.

6. Double-click on any log entry to go to that capture preview and timecode.
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Markers
You can add markers containing your comments to your media, and color code them for easier identification.

Adding Markers in the Timeline
NOTE: To view markers in the timeline, you must have the ‘Show markers on the timeline’ option enabled
in Settings.

To add a marker in the timeline:

1. Press the M key. A colored marker appears at the Timeline indicator position.

2. Double-click the marker.
3. A window with a text box and color palette opens.
4. Click on a color box to change the marker color, type text into the text box, and then click

elsewhere in the window to return to the browser.
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Adding Markers in the Logging Panel
To create a marker in your clip, do the following:

1. In the Logging panel, click on the Marker tab to open the Marker panel.

2. As your clip is playing in the media player, press the M key to insert a marker.
3. The marker displays in the Marker panel.
4. To color code a marker flag, select the marker and then click on the flag icon. From the

palette that opens, click on the color you require.

5. To update or add a comment:
a. Double-click on the Comments field.

Alternatively, select the marker and press Ctrl+E (Windows) or Cmd+E (Mac) to open the
Comments text box.

b. Type your new comment.
c. Press Enter to save your changes.

6. You can paste a timecode into any text field, as described in Inserting Timecodes into Text Fields.
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Removing a Marker Entry
To remove a marker entry from the Marker panel, click the entry to highlight it and then press the
Delete key. The marker is deleted.

Default Marker Color and Text
By default, markers you add during logging display a green flag, which you can change while logging.
You can change the default color for the marker, and assign standard text to this marker, e.g. ‘bad
lighting’. Do the following:

1. Click on the Cogs icon. The Settings Menu opens.
2. Click on the Options tab.

3. Double-click on the marker flag color. From the color palette that opens, click on the color
you want to use for your marker.

4. Double-click in the Default Marker Text box and enter the text you want to associate with
your selected marker color. Press Enter to save your text.

63



Predefined Markers
To save time, you can assign standard text to specific marker colors, e.g. red for ‘microphone in
shot’, violet for ‘bad sound’, etc. You can also assign keyboard shortcuts to activate your markers.

Using Predefined Markers
While logging, do one of the following:

● In the Predefined marks panel, click on the marker you want to insert at the designated
point in the timeline.

NOTE: When you hover the mouse over a Mark, a tooltip displays the marker text in full.

● Press the shortcut key assigned to the predefined marker you want to insert at the
designated point. See Creating Predefined Markers.
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Creating Predefined Markers
To create a predefined marker:

1. Click on the Cogs icon. The Settings Menu opens.
2. Click on the Predefined Markers tab.

3. Click the Add button (+).
4. A new marker displays in the window.
5. Double-click on the marker flag. From the color palette that opens, click on the color you

want to use for your marker.

6. Double-click on the Comment field and enter the text you want to associate with your
marker. Press Enter to save your text.

7. Double click on the shortcut field, and type the shortcut you want to use to activate your
marker when logging. For example press the Alt and G keys together to assign Alt+G as the
keyboard shortcut for your marker.
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Verbatim Text Logging
If you do not have any Logging templates defined, you can create free-form text in FLOW Logger and
add them to the Logging and Marker panels.

Adding Text to the Logging Panel
To add verbatim text to the Logging panel:

1. Check the Logging tab is selected.

2. At the point where you want to add logging data, type the text you require.
3. As soon as you start typing, a new log entry is created in the Logging panel.
4. When you have finished typing, press Enter. Your text is added to the new entry in the

Logging panel as a comment.
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Adding Text to the Markers Panel
To add verbatim text to the Markers panel:

1. With the Markers tab selected, start an ingest.

2. At the point where you want to add logging data, type the text you require.
3. As soon as you start typing, a new log entry is created in the Logging panel.
4. When you have finished typing, press Enter. Your text is added to the Markers panel as a comment.
5. Optional: To color code a marker flag, select the marker and then click on the flag icon. From

the palette that opens, click on the color you require.
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Importing and Exporting Logging Data

Importing Logging Data
You can import logging data for your media that has been collected from external HTML, XML, or
CSV format files. Complete the following:

1. If you are importing logging data, select the Logging tab. If you are importing marker data,
select the Markers tab.

2. Right-click in the panel, and from the menu that opens, select Import.
3. The Import dialog box opens.

4. Click the Folder button to open the file explorer window. Navigate to the folder the file to
import and then click OK.

5. Select the format you require for the import file: XML, CSV or Transcript (the Transcript
option is not available for marker import).

6. Information about the file you are importing displays in the Preview window.
7. Click the ‘Replace existing entries with matching timecode’ box if you want to overwrite

existing entries with import data that has the same timecode.
8. Click the Import button to complete the import operation.
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Exporting Logging Data
You can export data from the Markers panel into HTML, XML, or CSV formats. This could be used, for
example, to export product placement markers as a data source into a spreadsheet or database for
billing purposes. Do the following:

1. Select the Logging tab - Logging or Markers - containing the data you want to export. While
holding down the Shift or Ctrl key, click on the markers you want to export.

2. Right-click in the panel, and from the menu that opens, select Export.
3. The Export dialog box opens.

4. Select the format you require for the export file: HTML, XML or CSV.
5. The source text of the export file displays in the Preview window.
6. Click the ‘Include custom meta data’ box to include user-defined FLOW metadata.
7. Click the Folder button to open the file explorer window. Navigate to the folder where you

want to save the export file and then click OK.
8. Click the Export button to complete the export operation.
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Chapter 6: Customizing FLOW Logger
You can customize FLOW Logger through the Settings menu.

Settings Menu
To open the settings menu:

1. Click the Settings button.

2. The Settings dialog box opens on the Shortcuts tab.
3. The Settings menu has three tabs:

● Shortcuts Tab (see Keyboard Shortcuts)
● Options Tab
● Predefined Markers Tab (see Creating Predefined Markers).
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Options Tab
The Options tab sets general options within FLOW Browse:

1. In the Settings menu, click the Options tab.

2. Select the following options as required.
a. Enable Logging - Enables the generation of log files used for debugging.
b. Enable proxy file cache - Select this option if you are having problems playing back proxy

files of Geevs EWC captures that are in progress.
c. Auto refresh searches - Refreshes the search automatically at the interval selected in the

Refresh box ‘A’.
d. Auto refresh searches during scan and ingest - Refreshes searches during scan and

ingest.
e. Show verbatim text area - Displays the direct text entry window below the Markers panel
f. Enable log entries - Enables the Logging panel
g. Enable markers - Enables the Markers panel
h. Show log entries on timeline - Displays Thumbnails on the timeline. Unclick to hide thumbnails

if they are obscuring Markers, and to improve performance when switching angles.
i. Show Markers on timeline - Displays Markers on the timeline. Unclick to hide Markers if

they are obscuring thumbnails.
3. From the Capture View Label drop down list, choose to display one of the following labels in

the Capture List - Channel number, Clip Name or Source Name.
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The label displays below the previews for each channel that is ingesting.

4. Adjust the Markers reaction time using the up / down arrows. This setting compensates for
the reaction time of the user by inserting the marker ahead in the timeline by the value set.
For example, setting a reaction time of 0.5 seconds inserts a marker in the timeline 0.5 sec
ahead of the mouse click or keypress that initiated the marker.

5. To set the default marker color, do the following:
a. Click the color box. A color palette opens.

b. Click the color you want markers to display by default.
6. Type the text to display with the default marker color, e.g. ‘microphone in shot’.
7. Select the Media Browser tab you want displayed at startup from the Default tab drop down

list. The options are Media Spaces, Local, and Search.

Viewing FLOW Log Files
To view FLOW log files, see FLOW Application Logs.

Keyboard Shortcuts
The shortcuts described in this chapter are defaults in FLOW. You can add or remove shortcuts in
the Shortcuts tab of the FLOW Logger Settings dialog box.
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Using the Keyboard Shortcut Editor
The Keyboard Shortcut Editor allows you to create or modify keyboard shortcuts for several tasks in
FLOW.

1. If not already selected, in the Settings menu, click the Shortcuts tab.

2. Select a function in the left pane.
3. The function’s name, description, and keyboard shortcut appear in the right pane.
4. (Option) Type a new shortcut and click Add.
5. (Option) Select a function and click Remove to remove the shortcut.
6. (Option) Click the Show on the Toolbar box to display a shortcut for the selected function in

the toolbar.
7. The selected button displays in the toolbar, to the left of the Template drop down list.

8. Repeat steps 3 to 7 to add more buttons.
9. Click OK when finished.
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Default Shortcuts

Logger
Function Windows Mac

Switch to Capture 1
↓

Switch to Capture 8

Move In Point Back

Move in Point Forward

Move Out Point Back

Refresh Thumbnails Ctrl+R Ctrl+R

Slip log entry back

Slip log entry forward

Switch to File Logging Alt+B Alt+B

Ganged Capture Logging

Switch to Live Logging Alt+L Alt+L

Settings Ctrl+Shift+K Ctrl+Shift+K

Logging
Function Windows Mac

Remove log entry Shift+C
Ctrl+Shift+C

Shift+C
Ctrl+Shift+C

Clear In Point Shift+F9 Shift+F9

Clear Out Point Shift+F10
Ctrl+Shift+F10

Shift+F10
Ctrl+Shift+F10

Create In Point Ctrl+F9 Ctrl+F9

Edit Comment Ctrl+E Ctrl+E

Next Log Entry Ctrl+/F11 Ctrl+/F11
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Previous Log Entry Shift+F11 Shift+F11

Set In Point F9 F9

Set Out Point F10 F10

Set Poster Frame T T

Set Rating to 1
↓

Set Rating to 5

F1
↓

F5

F1
↓

F5

Markers
Function Windows Mac

Clear Marker Shift+M
Ctrl+Shift+M

Shift+M
Ctrl+Shift+M

Next Marker ]
Ctrl+]

]
Ctrl+]

Previous Marker [
Ctrl+[

[
Ctrl+[

Add Marker M
Ctrl+M

M
Ctrl+M

Marks
Function Windows Mac

Insert Timecode Ctrl+Shift+T Ctrl+Shift+T

Lock Dockable Windows

Quit Ctrl+Q Ctrl+Q

Redo Ctrl+Y Ctrl+Y

Refresh Ctrl+R Ctrl+R

Reset Layout

Search Ctrl+Shift+S Ctrl+Shift+S

Toggle Full Screen Ctrl+D Ctrl+D
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Undo Ctrl+Z Ctrl+Z

Group Member (Avatar)
Function Windows Mac

Decrease Icon Size Ctrl+Minus (-) Ctrl+Minus (-)

Increase Icon Size Ctrl+Plus (+) Ctrl+Plus (+)

Playback
Function Windows Mac

Fast Forward . (full stop)
Ctrl+.

. (full stop)
Ctrl+.

Jog Backward J
Ctrl+J

J
Ctrl+J

Jog Forward L L

Rewind , (comma)
Ctrl+,

, (comma)
Ctrl+,

Step Backward Left
Ctrl+Left

Left
Ctrl+Left

Step Backward x12 Shift+Left
Ctrl+Shift+Left

Shift+Left
Ctrl+Shift+Left

Step Forward Right
Ctrl+Right

Right
Ctrl+Right

Step Forward x12 Shift+Right
Ctrl+Shift+Right

Shift+Right
Ctrl+Shift+Right

Stop K
Ctrl+K

K
Ctrl+K

Cycle Aspect Ratio Ctrl+Shift+W Ctrl+Shift+W

Toggle Play Space
Ctrl+Space

Space
Ctrl+Space
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Chapter 7: Troubleshooting
If you are having problems with your FLOW system, see the following topics before you contact your
local EditShare Technical Support office:

● Network
● Media
● Logging
● Access
● Adobe Premiere Pro
● FLOW Application Logs

Network

Cannot Connect to FLOW Server
If you cannot connect to the FLOW Admin server:

1. If the IP Address text box displays in the login screen, check that the correct IP address or
server name is entered in the box.

2. Check your connection to the FLOW Admin server. Do the following:
a. Open a command line prompt and type ping <server name> where ping <server name>

is the hostname or IP Address of the AirFLOW server.
b. If no packets are returned, or the message destination host unreachable displays, check

the network cable connection to the LAN port of your workstation.
c. Check that your workstation is connected to the FLOW network. Check you have a

network cable connected and that the LAN port LED is flashing.
d. Server Groups option only: Check you are connected to the correct server group at login.

3. If you use Wi-Fi for working away from your organization, or for AirFLOW, ensure that Wi-Fi is
switched OFF when you are using a cable network connection for FLOW Browse, FLOW
Logger, Automation or FLOW Control.

4. If you still have no connection, contact the administrator for your FLOW system.

Cannot Log In
Check that you are using the correct username and password. Passwords are case sensitive, so
ensure the Caps Lock key is OFF.

‘Service temporarily unavailable’ Message
If the message, ‘The FLOW / Browse / Logger Service is temporarily unavailable’ displays, the server
is in maintenance mode. Functions and content are not available at this time. The Administrator for
your FLOW system can advise when the server can be accessed again.
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No Network Folders or Media Spaces are Visible
Check the following:

● Check the server you are trying to access is online and connected to the network.
● You have to be a member of a Media space in order to view or use it. See One or More

Media Spaces are not Visible.

Connection to EditShare Media Spaces requires an EditShare Storage server with an active FLOW
login account. The Administrator for your FLOW system can advise if this is the case.

One or More Media Spaces are not Visible
You cannot access a Media Space if you have not been designated a member of it. If you think you
should be a member of a particular Media Space, ask the Administrator for your FLOW system.

Media

Cannot Access or Play Clips
Check the following:

● There is a proxy available for the clip you want to play.
● If there is not a proxy for the clip you want to play, the drive containing the source material

may not be mounted in FLOW. Contact the administrator for your FLOW system.
● There may be a problem with the disk drives on the server you are trying to access. Contact

the administrator for your FLOW system.

Clips will not Play
Check the following:

● FLOW supports a large range of video and image formats. To check that your video formats
are supported by FLOW, see the FLOW Supported Formats Guide.

● It is important to keep your FLOW software up to date in order to take advantage of the
latest codecs and drivers that are available.

Audio not Present
Check the following:

● Confirm audio is present on the source material.
● Check audio connections to the FLOW Ingest server.
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Logging

Cannot see any Logging Templates or Groups
The templates, groups, action and event descriptors you use Logger in FLOW Logger are pre-defined
in templates set up in FLOW Control. You can edit these templates and add new ones if you have
Administrator level access in FLOW. Refer to the EditShare FLOW Administrator’s Guide for further
information.

Cannot Log Live Media
To enable Live Logging Mode, you must be currently ingesting a media source connected to an SDI
input on the FLOW Ingest server. If you select a FLOW channel on which ingesting was not started,
the Logger In, Out, and Log buttons do not function.

File Logging Mode is not affected by this condition.

Access

Client Functions are Unavailable
Some of the functions described in this guide may not be available.

These functions may have been blocked on your FLOW user account. If you feel you require any of
these functions, you should talk to the administrator for your FLOW system.

Some of the features documented in this guide may not be available as standard but may be
ordered as an option, or require additional licensing. Contact your local EditShare reseller for details.
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Adobe Premiere Pro

Importing QuickTime Media Creates New Copy
When importing or dragging QuickTime media from FLOW, Adobe Premiere Pro inserts additional
metadata (XMP) into your files. This has the side effect of modifying the file, causing it to appear in
FLOW as a new file while the original file appears to be Offline.

You can prevent Premiere Pro from modifying your files in this manner by doing the following:

1. In Adobe Premiere Pro, select Edit > Preferences > Media.
2. Un-select the box ‘Write XMP ID to Files on Import’.

3. Click OK.
4. Restart Premiere Pro.
5. You can now drag clips from FLOW into Premiere Pro without them being modified.

For more information on XMP metadata in Premiere Pro, go to Adobe's support page at
http://helpx.adobe.com/premiere-pro/topics.html, and look for ‘Managing Metadata’.

Start Timecode for ES-QuickTime MOV files
When using ES-QuickTime MOV files in Adobe Premiere Pro, the Start timecode can revert to zero.
Upgrading to the latest version of Adobe Premiere Pro fixes this issue.
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FLOW Application Logs
When you contact Technical Support, they may ask you for copies of your recent logs. These logs
may contain information relating to issues with your FLOW applications. To open the folder
containing FLOW log files:

1. Click on the Settings menu button (Cogs icon).

2. When the Settings menu opens, click the Options tab.
3. Click the Open Logs button.
4. The Explorer (Windows) or Finder (Mac) file manager for your system opens in the folder

containing the log files for your FLOW application.
5. Log file names are in the format:

[application-name]-[date]-[time]-000.log

A log file without a [date]-[time]suffix is the latest log file.

6. If logging is disabled in FLOW Logger, click the ‘Enable logging’ box to restart it.
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Log Files in macOS / OS X Clients
FLOW client logs on macOS /OS X systems are located below the User Library Folder
(/Users/{Username}/Library/) which the operating system hides by default. Before you can open
the log files, you must reveal the User Library Folder:

1. Open Finder and click on the Home folder.
2. Select View > Show View Options - or press Cmd+J.

3. In the menu that opens, click 'Show Library Folder'.
4. The User Library Folder opens in Finder.
5. Logs for each FLOW client application can be found in the path:

/Users/{Username}/Library/Application Support/EditShare/{FLOW Client Name}/'
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Appendix A: EditShare Connect
Quick Start
EditShare Connect is the client application for EditShare Storage, and is available for Windows and
Macintosh operating systems. It mounts EditShare media and project spaces, remembering your
preferences, and provides non-Avid users with an interface for sharing projects.

For topics not described in this Appendix, refer to the EditShare Storage Editor’s Guide.

Overview

Media Spaces
There are several types of media spaces:

Unmanaged - These are the simplest spaces, providing a shared space for non-Avid media files, as
well as non-media files, such as application launchers and documents. Any user who has read / write
access to an Unmanaged space may delete, rename, or move any file on the space.

Managed - These spaces accommodate the same types of files as Unmanaged spaces. However,
users who create files and folders in Managed spaces, own those files and folders. Users cannot
delete, rename, or move files unless they own them.

Universal - These spaces are designed for EditShare Universal Media Files™, which can be read by
both Avid and QuickTime-compatible applications. See ‘Universal Media Files’ in the FLOW Browse
User’s Guide.

Avid Style - These spaces are designed for Avid media and project files. They are functionally similar
to shared spaces on Avid storage products. Avid Style spaces provide an Avid-compatible folder
structure for media and thereby allow multiple Avid workstations to share the same media files.

Avid Style spaces also allow editors to create shared Avid projects, in which the first user to open a bin
gets read and write access. Other users get read-only access until the bin is closed by the first user.

See also ‘Avid Style Media Spaces’ in the FLOW Browse User’s Guide.

Avid MXF - Avid MXF media spaces are used for legacy systems only.

NOTE: EditShare strongly recommends using the Managed, Unmanaged, and Avid Style media spaces,
which are designed for the vast majority of current editing workflows. Refer to the EditShare Storage
Editor’s Guide for further information.
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Shared Project Spaces
EditShare Lockable Project Spaces allow you to safely store and share project files from your NLE in
a central location that can be accessed and written to by other users at the same time. In this
workflow, project files are not stored in the same place as media files and render files, but are
stored separately in an EditShare Lockable Project Space. In this project space, EditShare rules
ensure each project file can only be opened for writing by one user at a time.

When you make a new project in a Lockable Project Space, you are creating a top level Project Folder
where you and your colleagues can store the various files that make up your project. Thus large
projects can be broken down into smaller ones so that each editor has control over the portion of
the project they are working on. For example, one editor can work on Scene 1 while another editor
works on Scene 2. Both scenes are part of the same movie, but each scene is represented by a
separate project file.

When you want to work on a particular project file, you unlock it - giving you exclusive write access
to that file, and locking it for other users. Although a project file may be locked for other users, they
still have read-only access to your project file, allowing them to play and review its contents. Users
can also import elements from locked project files into project files they control.

Starting EditShare Connect
To start EditShare Connect, do the following:

1. Click on the EditShare Connect desktop icon.

2. The login dialog box displays.

3. Enter the IP Address for the EditShare server in the Address text box.
4. Enter your EditShare user name in the User Name text box.
5. Enter your password in the Password text box.

84



6. Click the Remember Me box if you want to save your Login profile.
7. Click the Login button.

Mounting Media and Project Spaces
NOTE: See the EditShare Storage Editor’s Guide for detailed descriptions of Media Space types
(Unmanaged, Managed, Avid Style, and so on.) and Project Space types (Avid, Non-Avid, Lockable).

EditShare Connect allows you view all EditShare Spaces you have access to and mount them on your
workstation. If you are using EditShare 7, mounted spaces are preserved irrespective of which
workstation you logged in from.

To mount Media Spaces, do the following:

1. Click on the Spaces tab.

2. Mount your Media Spaces and / or Shared Project Spaces by clicking on the associated drop
down box and selecting one of the following options:
● Drive letter for Windows workstations
● AFP or SMB for Mac OS X workstations

3. After mounting, Media Spaces display as network mounts in Windows Explorer or Mac OS X
desktop. The Media Spaces can be browsed and used as media drives in FLOW and your NLE.
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Creating a Shared Project Space
To create a shared project space, do the following:

1. Open EditShare Connect and login with a valid username and password.
2. Mount a Shared Project Space in the Network Shares tab.
3. Click the Project Browser tab.

4. From the Project Space drop down list, select the Shared Project Space where you want to
store your project.

5. Click the New Project button.
6. The New Project dialog box opens.
7. Type a name for the project and click OK. This defines a new upper-level directory inside

which you will see User Folders for every member of the Shared Project Space.
8. Launch your NLE application and save your NLE project files inside your own User Folder in

the Shared Project Space.

NOTE:  You can also copy existing NLE project files into your own user folder through Finder or
Windows Explorer.

Adding Folders to Media Spaces
Once you have mapped a Media Space, you can create folders within that space using the Explorer
(Windows) or Finder (Macintosh) file manager on your workstation.
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